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1.0 Introduction 

 

A PSCAD model of the region covered by grid zones 11 and 13, including the HVDC bipole, was 
developed for asset owners to conduct their own Electromagnetic Transient (EMT) connection 
studies in this region as per Connection Study Requirements for New Generating Assets (GL-EA-
0953)1. The model contains detailed representations of grid zones 11 and 13, while the rest of the 
South Island grid network is represented by equivalent voltage sources and a simplified network. The 
model includes a simplified HVDC link with inverter stations connected to an equivalent network 
representing the Haywards 220 kV bus. The model contains synchronous generator models along 
with their respective automatic voltage regulators (AVR) and reactive power compensation devices 
modelled using simplified generic models. 

The EMT network model components were created using E-TRAN software developed by Electranix 
Corporation2. The power-flow solution and network equivalent were created using DigSILENT 
PowerFactory. This document provides guidance for loading the network model into PSCAD, along 
with brief descriptions of the models.   

  

 

1 Connecting generation | Transpower 
2 E-TRAN Runtime library for PSCAD | Electranix Corporation 

https://www.transpower.co.nz/system-operator/information-industry/asset-owner-requirements/connecting-generation
https://www.electranix.com/software/e-tran-runtime-library-for-pscad/


TRANSPOWER NEW ZEALAND   |   GRID ZONE 11, 13 EMT MODEL USER GUIDE 2 

2.0 Files Provided by the System Operator  

The system operator provides the asset owner with the GZ_11_13_EMT_model .zip package 
containing files shown in Figure 1. Table 1 includes descriptions of the files provided in the .zip 
package.  

 

Figure 1: Files provided in the .zip file. 

 

Table 1: Description of the files provided. 

File name Description 

dynamics.dyr Dynamic record file for generator and AVR/exciter models. This file 

should be placed in the same folder as the EMT_11_13.pscx case. 

EMT_11_13.pscx  A simulation file containing South Island grid zones 11 and 13, including 

a simple model of the HVDC bipole link connected to an equivalent 

source at Haywards. The South Island model has boundaries at Clyde 

220 kV, Livingstone 220 kV, Islington 220 kV buses. 

ETRAN.pslx The runtime library developed by Electranix to be used with E-TRAN-

converted PSCAD files. The latest version of this library is freely available 

on the Electranix website3. 

ETRAN_IF12.lib The encrypted source code file for E-TRAN runtime library. This should 

be loaded as a resource file in the ETRAN.pslx library. 

loads.csv A .csv file containing details of the loads within the network model. The 

data is obtained by the PowerFactory power-flow solution. 

synchronous_machines.csv A .csv file containing details of the synchronous machines within the 

network model. The data is obtained by the PowerFactory power-flow 

solution. 

 

3 E-TRAN Runtime library for PSCAD | Electranix Corporation 

https://www.electranix.com/software/e-tran-runtime-library-for-pscad/
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File name Description 

update_loads.py A python file used to update the load values based on the power-flow 

details provided by the loads.csv file. 

update_syncmachines.py A python file used to update the initial conditions of synchronous 

machines based on the power-flow details provided by the 

synchronous_machines.csv file. 

WP_11_13.pswx This is a PSCAD workspace file which should load all necessary files into 

the PSCAD workspace to run the PSCAD case. 
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3.0 Setting up the Study Case 

The package is created using PSCAD V5.0.2 with Intel Fortran Classic 2021.12.0 compiler and Visual 
Studio 2022 installed.  Loading the package into older PSCAD versions and/or with an older Intel 
Fortran compiler and Visual studio version may cause the study case to fail. This section explains the 
steps required to load the study case.   

3.1 Loading the Case File and General Setup 

Once the provided .zip file is extracted, the user can open the WP_11_13.pswx workspace file. This 
should load all necessary files and resources into the PSCAD environment. If the workspace fails to 
load correctly, the user can follow the sequence to load all the files manually. 

Use the File -> Open command from PSCAD to load both files below.   

1. ETRAN.pslx 
2. EMT_11_13.pscx 

Once these two files are loaded, expand the ETRAN.pslx library by clicking the + sign beside the file 
name in the workspace. Right-click on the Resources subfolder and navigate to Add -> Binary (*.o, 
*.obj, *.lib) submenu.   

 

Figure 2: Adding .lib files to the project. 

 

Then add the ETRAN_IF12.lib file as shown in Figure 3.  

 

Figure 3: All the .lib files loaded in correct order. 

The following figure shows a snapshot of the PSCAD workspace after the workspace WP_11_13.pswx 
is correctly loaded.  
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Figure 4: Screenshot of the correctly loaded PSCAD workspace and canvas. 

 

3.2 Case File Arrangement 

The network model is divided into four main subpages: 

1. North Island Equivalent subpage  
2. HVDC Generic subpage 
3. GZ 13 Otago subpage 
4. GZ 11 Canterbury subpage 

The subpages are distributed in the canvas as shown in Figure 5. 

 

Figure 5: Main page of PSCAD workspace. 

 



TRANSPOWER NEW ZEALAND   |   GRID ZONE 11, 13 EMT MODEL USER GUIDE 6 

3.3 Setting Up the Compiler 

An Intel® Fortran Compiler is required to run the simulation case. The simulation cases were 
developed using Intel® Fortran Compiler Classic 2021.12.0 compiler. The user must make sure a 
correct version of Intel Fortran compiler is installed on the computer4. The compiler can be selected 
by navigating to File -> Application Options -> Dependencies and selecting the correct Fortran 
compiler. Figure 6 shows the window to configure the Fortran compiler. 

 

 

Figure 6: Setting up the compiler. 

 

3.4 Setting Up the Project Simulation Time Step 

Setting up the correct simulation time step is crucial for accurate results. It is essential to run the 
simulation at a time step (solution time step) at 20 µs or below due to the modelling requirements. 
Users can use a slightly larger channel plot step to reduce the memory usage from the simulation. In 
this configuration, a 100 µs channel plot step is recommended. All these parameters can be changed 
in the Project Settings by right-clicking anywhere on the canvas as shown in Figure 7. 

 

4 Compatibility of compilers and Visual Studio versions with PSCAD versions can be found at 
https://www.pscad.com/knowledge-base/article/102  

https://www.pscad.com/knowledge-base/article/102
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Figure 7: Setting up the solution time step. 
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4.0 Simulation Case Details 

The simulation case was developed based on the EMI PowerFactory study case for 202311, available 
on the Electricity Authority’s website5. The summer 2024 variation has been considered to obtain 
the minimum strength in the system.  

Users may replicate the power flow conditions by creating equivalents for other load condition 
variations or by updating the case using the latest version of the EMI study. For further assistance, 
please contact the system operator. 

4.1 Network Equivalents 

The simulation model contains only regions associated with grid zones 11 and 13, including the HVDC 
system. The rest of the network is represented by equivalent voltage sources and a network to 
simplify the EMT simulation. Since the EMI case is built separately for the two islands, the equivalents 
should be carefully calculated. 

The EMT model is made considering 700 MW flow in HVDC link at Haywards 220 kV bus. The HVDC 
link has a loss of around 20 MW at this operating point. Considering this, the EMI PowerFactory case 
needs be reconfigured to have constant HVDC export of 720 MW (remove the slack control at HVDC). 
For the North Island, the network reduction will only include the Haywards station. The slack 
generator was set to HVDC static generator in the EMI case with the voltage angle of Haywards 220 
kV bus at 0°. The network was reduced based on the following selected boundary of the EMI 
PowerFactory case.  

 

 

Figure 8: EMI PowerFactory boundary for reducing North Island Power Grid. 

Once the network boundary is created in PowerFactory (named Boundary-HAYWARDS in this 
example), part of the network exterior to the boundary can be reduced via CALCULATION -> Network 
Reduction in PowerFactory. This will open the Network Reduction window. In this window, 

 

5 Electricity Authority - EMI (market statistics and tools) (ea.govt.nz) 

https://www.emi.ea.govt.nz/Wholesale/Datasets/Transmission/PowerSystemAnalysis/PowerFactoryCaseFiles
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parameters should be set as follows to create an Extended Ward Reduction. Leave other settings as 
default. Once the settings are configured, press Execute6. 

 

Figure 9: Network Reduction window: Basic Options. 

 

 

Figure 10: Network Reduction window: Ward Equivalent. 

 

Once the network is reduced, AC voltage sources and Common Impedances appear in the 
PowerFactory network data. The magnitude, angle, initial active and reactive powers of the 
equivalent network AC voltage sources, as well as network impedances between equivalent AC 
voltage sources in the EMT model were set based on the power-flow solution of the reduced 
PowerFactory case.  

Similarly, the South Island power grid slack generator was changed to BEN G1 with Benmore 220 kV 
bus voltage angle defined at 0°. The network was reduced based on the following selected boundary 
of the EMI PowerFactory case. 

 

6 Additional information regarding Network Reduction is available in the PowerFactory user manual. 



TRANSPOWER NEW ZEALAND   |   GRID ZONE 11, 13 EMT MODEL USER GUIDE 10 

 

Figure 11: EMI PowerFactory boundary for reducing South Island power grid. 

 

Once the network is reduced7, AC voltage sources and Common Impedances appear in the 
PowerFactory network data. The magnitude, angle, initial active and reactive powers of the 
equivalent network impedances and equivalent network AC voltage sources in the EMT model were 
set based on the power-flow solution of the reduced PowerFactory case.  

 

Figure 12: Network equivalent in GZ 13 Otago subpage. 

 

 

Figure 13: Network equivalent in GZ 11 Canterbury subpage. 

 

4.2 HVDC Model 

A generic bipole HVDC model available in the PSCAD Knowledge Base8 was used for the HVDC link. 
Only converter controls are implemented without bipole controls. Figure 14 shows a schematic of 
the HVDC model. 

 

 

7 Ward reduction available in PowerFactory 2021 was used to reduce the network. 
8 https://www.pscad.com/knowledge-base/article/190  

https://www.pscad.com/knowledge-base/article/190
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Figure 14: Generic HVDC model. 

 

When conducting power-flow analysis in the EMI case, the converter transformer tap positions need 
to be manually adjusted to match the reactive power-flow into the converter stations. The simulation 
model is set to send power from the South Island to North Island. The active power setpoint at 
Haywards 220 kV can be set by adjusting the Bipole Power Order [MW] slider on the HVDC Generic 
subpage.  

The filters at Haywards and Benmore need to be adjusted based on the active power setpoint. Figure 
15 and Figure 16 show the filter bank construction.  

A STATCOM is available at Haywards 220 kV bus; this is modelled as a generic STATCOM model. The 
reactive power response of the STATCOM heavily affects the voltage recovery following faults closer 
to Haywards station. 

Note: No reactive power controller (RPC) is implemented in the generic HVDC model.   
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Figure 15: Filter bank at Haywards. 

 

 

Figure 16: Filter bank at Benmore. 

 

The filters are selected based on the bipole/monopole operation and the DC power transfer. Table 
2 to Table 5 present how the filters are switched on/off at Benmore and at Haywards based on the 
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power setpoint and bipole/monopole operation. The available DC power transfer shown for 
performance will be used to switch in the next filter. 

 

Table 2: Filter selection for Haywards bipole operation. 

In Service Combination 
Performance 

(MW) 
DC link rating 

(MW) 
F3A/ F4A F3B/ F4B F5A/F6A F5B 

0 0 1 1 0 70 

0 1 1 1 140 140 

0 1 2 1 490 490 

1 1 2 1 1000 1200 

2 1 2 1 1200 1200 

2 2 2 1 1400 1400 

 

Table 3: Filter selection for Haywards monopole operation. 

In Service Combination 
Performance 

(MW) 
DC link rating 

(MW) 
F3A/ F4A F3B/ F4B F5A/F6A F5B 

0 0 1 0 0 70 

0 0 1 1 210 350 

0 1 1 1 245 350 

0 1 2 1 700 1000 

1 1 2 1 1000 1000 

1 2 2 1 1000 1000 

2 2 2 1 1000 1000 
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Table 4: Filter selection for Benmore bipole operation. 

In Service Combination 
Performance 

(MW) 
DC link rating 

(MW) 
F3/F4 F5/F6 F7 

1 0 0 0 140 

0 1 0 0 140 

1 1 0 350 350 

1 2 0 560 1200 

1 2 1 1200 1200 

2 2 1 1400 1400 

 

Table 5:Filter selection for Benmore monopole operation. 

In Service Combination 
Performance 

(MW) 
DC link rating 

(MW) 
F3/F4 F5/F6 F7 

0 1 0 280 350 

1 1 0 420 700 

1 1 1 700 1000 

1 2 1 1000 1000 

2 2 1 1000 1000 

 

4.2.1 North Island Equivalent Subpage 

This subpage represents the Haywards 220 kV and 110 kV bus bars with interconnecting 
transformers, synchronous condensers and Haywards STATCOM (a generic STATCOM model is used). 
The rest of the North Island is represented by two equivalent voltage sources connected at Haywards 
220 kV and 110 kV buses and a fictitious interconnecting transformer connected between the two 
buses. 

Figure 17 provides an overview of the North Island Equivalent subpage. 
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Figure 17: Haywards equivalent subpage overview. 

 

4.3 GZ 13 Otago Subpage 

This subpage consists of a detailed model of the Otago region, including major hydro generators 
within the region. The region of the South Island network within the green line in Figure 18 is covered 
in the GZ 13 Otago subpage. 
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Figure 18: Region represented on the GZ 13 Otago subpage. 

 

4.3.1 Generation Within the Region 

Name of the 
Generator 

Capacity (MVA) Dispatch (MW) Energy Source Model 

Waitaki (WTK) 16.67 
16.67 
16.67 
16.67 
16.67 
16.67 
16.67 

15.0 
15.0 
15.0 
15.0 
15.0 
1.77 
OOS 

Hydro GENSAE 
 

Aviemore (AVI) 61.0 
61.0 
61.0 
61.0 

58.0 
58.0 
57.3 
OOS 

Hydro PSCAD master 
library 

Synchronous 
machine model 

(Saturation curve 
by table) 

Benmore (BEN) 112.5 
112.5 
112.5 
112.5 

83.6 
90.0 
90.0 
90.0 

Hydro PSCAD master 
library 

Synchronous 
machine model 
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Name of the 
Generator 

Capacity (MVA) Dispatch (MW) Energy Source Model 

112.5 
112.5 

90.0 
95.0 

(Saturation curve 
by table) 

Ohau A (OHA) 73.33 
73.33 
73.33 
73.33 

66.0 
66.0 
48.0 
20.5 

Hydro GENSAE 
 

Ohau B (OHB) 58.889 
58.889 
58.889 
58.889 

53.0 
53.0 
53.0 
30.0 

Hydro GENSAE 
 

Ohau C (OHC) 58.889 
58.889 
58.889 
58.889 

52.0 
53.0 
53.0 
29.0 

Hydro GENSAE 
 

Tekapo B (TKB) 88.9 
88.9 

78.0 
65.0 

Hydro GENSAE 

Clyde (CYD) 120.0 
120.0 
120.0 
120.0 

OOS 
94.5 
94.5 
94.5 

Hydro GENSAE 

Roaring Meg 
(RMG) (LMG and 
UMG) 

2.5 
1.0 

0.54 
0.86 

1.5 
0.8 
0.4 
0.7 

Hydro GENSAE 

 

4.4 GZ 11 Canterbury Subpage 

The subpage consists of a detailed model of the Canterbury region, including major hydro generators 
within the region. The region of the South Island network within the green line in Figure 19 is covered 
on the GZ 11 Canterbury subpage. 
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Figure 19: Region represented on the GZ 11 Canterbury subpage. 

 

4.4.1 Generation Within the Region 

Name of the 
Generator 

Capacity (MVA) Dispatch (MW) Energy Source Model 

Tekapo A (TKA) 35.0 20.0 Hydro GENSAE 

 

 

4.5 Generator Models 

Due to the sensitivity of the information regarding models of generators, generic models have been 
used to model the generators. Synchronous machines are modelled using GENSAE, and PSCAD library 
synchronous machine models with their automatic voltage regulators using respective IEEE generic 
models.  

 

4.6 Load Model 

The active and reactive power components of the loads at grid exit points (GXPs) are modelled as 
constant current sources and constant impedance models respectively to align with the widely 
accepted load dynamic characteristics9. 

 

9 Kundur, Prabha S., and Om P. Malik. 2022. Power System Stability and Control. 2nd ed. New York: McGraw 
Hill. 
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Figure 20: Example load representation. 

 

4.7 Enable Additional Plot Channels 

The simulation model consists of signals set up for plotting for observation and troubleshooting of 
the characteristics within the simulation model. Reducing the number of plotted signals helps to 
reduce usage of computer memory and increase simulation speed. These non-essential signal plots 
are included in a layer named Additional_plot_channels. This layer can be enabled/disabled from 
the Layers pane (View Tab -> Panes -> Layers) to plot these additional signals.  

 

 

Figure 21: Enable/disable plotting of non-essential signals. 

  

Constant Current – Active 
Power Component

Constant Impedance – 
Reactive Power Component
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5.0 Update Initial Conditions using Power-flow Data 

 

The update_syncmachines.py and update_loads.py scripts can be used along with 
synchronous_machines.csv and loads.csv to rapidly update the initial conditions of the synchronous 
machines and load values based on the power-flow solution.  

 

5.1 Update Synchronous Machines 

Step 1 

First, the synchronous_machines.csv needs to be updated based on the power-flow solution. Figure 
22 gives an overview of the .csv file data format opened in Excel.  

Note: the user must not change the generator names, data order or format.  

 

 

Figure 22: Data format of the synchronous_machines.csv file. 

 

The same generator name used in the EMI case is used in the first column. Columns B and C can be 
left null or populated. Columns D to H need to be updated based on the PowerFactory power-flow 
solution. Once the .csv file is updated, save it in the same folder where the PSCAD case is saved. 

 

Step 2 

Add update_syncmachines.py as a resource to the PSCAD case. Figure 23 gives a snapshot of adding 
the python file to EMT_11_13.pscx. 
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Figure 23: Addition of update_syncmachines.py script. 

 

Step 3 

Double-click the added update_syncmachines.py file. This will open a scripts pane in the PSCAD 
environment. 

 

Figure 24: Scripts pane with the loaded script. 

 

Step 4 

Update the project_name variable with the current PSCAD case that needs to be edited.  

Update the sync_machine_data variable with the absolute file location of the 
synchronous_machines.csv file. 
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Figure 25: Update the project name and sync_machine_data variables. 

 

Step 5 

Press the Run button available in Scripts pane. This should update the synchronous machines within 
the PSCAD case with the data provided in the synchronous_machines.csv file. The Script Output will 
be populated with generators that are being updated. 

  

5.2 Update Loads 

Step 1 

Update the loads.csv based on the power-flow solution. Figure 26 gives an overview of the .csv file 
data format opened in Excel.  

Note: The user must not change the load names, data order or format.  

 

 

Figure 26: Data format of the loads.csv file. 

 

The same load name used in the EMI case is used in the first column. Column B can be left null or 
populated. Columns C to F need to be updated based on the PowerFactory power-flow solution. 
Once the .csv file is updated, save it in the same folder where the PSCAD case is saved. 
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Step 2 

Add update_loads.py as a resource to the PSCAD case like in section 5.1.  

 

Step 3 

Double-click the added update_loads.py file. This will open a scripts pane in the PSCAD environment. 

 

Figure 27: Scripts pane with the loaded script. 

 

Step 4 

Update the project_name variable with the current PSCAD case that needs to be edited.  

Update the load_data variable with the absolute file location of the loads.csv file. 

 

Figure 28. Update the project name and load_data variables. 

Step 5 

Press the Run button available in Scripts pane. This should update the synchronous machines within 
the PSCAD case with the data provided in loads.csv file. The Script Output will be populated with 
loads that are being updated.  
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6.0 Assumptions and Limitations of the Model 

The EMT_11_13.pscx PSCAD network model is provided with the following assumptions and 
limitations. 

• It contains Grid Zone 11 and 13 transmission networks modelled in detail, including all the 
associated voltage control system model for generators. The HVDC link is presented with a 
simple generic model. The rest of the North Island and South Island networks are modelled 
as equivalent networks, with equivalent generators modelled as a constant frequency AC 
voltage source. This PSCAD network model is suitable for fault ride through and other 
voltage-related system studies.  

• The simulation model requires an Intel® Fortran Compiler Classic 2021.12.0 to compile the 
simulation case.    

• The simulation case was built using PSCAD version 5.0.2.0. 

• The simulation case was developed with Visual Studio 2022. 

• The EMT model has been created for a specific operating point of the power system (2024 
Summer loading in EMI case). Users can modify the system for different study scenarios using 
the provided python scripts.  

• The dynamics of machines are released at 3.0 s of the simulation run. Thus, it is 
recommended to run the simulation further about 3-5 s to ensure the system is in steady 
state. Verify the system is in steady state prior to conducting the studies.  

• The EMT model was converted from the power-flow file using a 20 µs simulation time step. 
Users could reduce the time step further if required, but increasing the simulation time step 
would likely result in error when performing the simulation.  

• The simulation model used simplifies generic models for HVDC links and STATCOMs due to 
the restrictions of using detailed models. The response of the generic models may not fully 
represent the behaviour of the actual asset(s). 

• The python scripts provided with the model only update the initial condition of generators 
and load values. The transformer tap positions, equivalent network initial conditions and 
equivalent network impedances, filter configurations, static capacitors and inductors within 
the system are NOT updated automatically. It is highly recommended that users verify all 
parameters and dispatch against the EMI PowerFactory case.  

• The generator internal angles of Roaring Meg (within the LMG GEN subpage) is different to 
that of the PowerFactory power-flow solution. The Cromwell GXP transformer phase shift 
cannot be correctly modelled in PSCAD transformers. With the implemented transformers, 
the Roaring Meg generator internal angles need to be advanced by +90° (E.g. if PowerFactory 
angle is -100°, use -10° in PSCAD). 

• Studholme (STU) is supplied from Timaru (TIM) in summer and Waitaki (WTK) in winter. This 
requires lines to be taken on outage depending on the season of study. 
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